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      How to convert a PDF to a GIF?

We share all sorts of data and documents using PDF files, and this means that they always contain a number of images, multiple pages, and different formats. PDFs often give us the advantage of lower file size, but this can often lead to a compromise in image quality as well. This is one of the main reasons why users sometimes feel the need to convert PDF files or selected PDF pages into GIF format. However, since the file contains several images and pages, this conversion becomes a tricky procedure, particularly due to the fact that a GIF file doesn't support multiple pages and is exclusively reserved for images. So how do you convert a PDF file format to the GIF file format? This article introduces you to the best solution to convert PDF to GIF for both Windows and Mac users.

	Part 1. How to Convert PDF to GIF File on Mac and Windows (Editor Pick!)
	Part 2. How to Convert PDF to GIF in Adobe Acrobat
	Part 3. How to Convert PDF to GIF in Preview on Mac
	Part 4. 3 Other Recommended PDF to GIF Converter 




Part 1. How to Convert PDF into GIF File on Mac and Windows (Editor Pick!)

1. Why Choose PDFelement

Some of the main features that PDFelement ProPDFelement Pro has to offer include highly powerful editing tools that allow you to add texts, links, images, notes and watermarks onto your PDF files, the ability to create and fill out PDF forms, the option of combining and splitting PDF documents, controlling your PDF pages, password protection, etc.



	TRY IT FREE 
    TRY IT FREE 


Key features:

	Easily convert PDF to Images, Word, Excel, PPT, EPUB and other formats.
	Convert PDF to other file formats in batch and convert scanned PDFs with ease.
	Edit PDF texts, graphics, images, links, watermarks in a simple way.
	Create PDF from other formats and create PDF forms easily.
	Easily mark up and annotate PDF files with multiple markup tools.
	Combine multiple files into PDF and split PDF into several files.






2. How to Convert PDF to GIF File on Mac (Including macOS 10.15 Catalina)

If you're looking to convert your PDF files to GIF, the best software to look forward to is PDFelement. In addition to GIF, it also supports converting PDF to many other popular file formats. The software supports macOS 10.15 Catalina, macOS 10.14 Mojave, macOS 10.13 High Sierra, as well as older versions. PDFelement for Mac is free to download and easy to use, doesn't require too much disk space, and gets the job done in less than a minute. Here is a step-by-step guide that shows you how to convert a PDF to GIF using this PDF to GIF Converter.
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Step 1. Load the Target PDF File

Open the PDF file that you wish to convert with PDF Editor 6 Professional for Mac software. To do this, simply launch the program and then click on the "Open" option in the program interface. Once the PDF file opens, you can perform any edits that you need before converting the file to a GIF file format.



Step 2. Start the Conversion Process

In order to convert to GIF, you need to click on the "Tool" button located on the top toolbar and choose "PDF Converter." After clicking on the button, a pop-up window opens up. Select "Image > GIF" as the output format. You can further tweak the conversion settings by clicking on the "Gear" icon.

Once you're ready to convert the file, simply click on the "Apply" button. The converted GIF file can be found in the destination folder.



Step 3. Batch convert from PDF to GIF

To convert multiple PDF files, you need to click "Add Files" to import PDF files to the opened window and you can set the output format, document language on the right-side toolbar. After that, click "Apply" to start converting PDF files in batch.





3. How to Convert a PDF to a GIF on Windows

PDFelement allows you to edit your PDF files and documents the way Word processors allow you to. The software supports Windows XP, Vista, 7 and 8, and 10. It comes with a host of features such as the option to markup and annotates your PDF, edit and convert scanned PDF files, merge or split PDF files, password protect PDF documents, and convert PDF files into different file formats. This makes PDFelement for Windows one of the top PDF editing software for all your PDF editing or converting needs.

One file format that is particularly difficult to convert to is GIF. This step-by-step guide shows you how to convert PDF documents to GIF files on Windows using PDFelement for Windows.
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Step 1. Add PDF to the Program

Launch the PDF GIF Converter and open the PDF file. To do so, simply click on the "Open Files" button and select the PDF file that you wish to convert. Once the file displays on your screen, you can make any necessary edits to the file that are needed before conversion.



Step 2. Convert from PDF to GIF

After making all necessary edits, click on the "To Image" option located in the "Convert" menu. Select the "GIF" file format and click on the "Convert" button. The software shall automatically convert your PDF file to GIF and save it in the destination folder.



Step 3. Convert PDF files in batch

If you want to convert PDF files in batch, you just need to go to the welcome page of this program. Then open the "Batch Progress" tab. Select the "Convert" feature on the left side and add multiple files from your computer. After that, click on the "Apply" button to start converting multiple PDF files.



Tips

Remember, converting your PDF file into different file formats doesn't necessarily have to be a complicated process. With the right software, working on PDF files becomes as easy as working on Microsoft Word files. Here are a few tips to make the entire process simpler.



	The converted file always gets saved in the destination folder (the folder where you request the software to save files) on your computer.
	It is entirely possible to convert specific portions of your PDF file into a GIF file. Simply look for the advanced options that can be accessed by clicking the Gear icon.




Part 2. How to Convert PDF to GIF in Adobe Acrobat

From the innovators of the PDF document comes the ingenious PDF Editor, Adobe Acrobat. It is an intricately designed software to help you execute all PDF conversions. It has got many more fantastic features such as the ability to edit PDFs, simplicity to create a PDF, a digitized way to sign, certify and verify PDFs, an easier way to read on a high contrast mode with dynamic background adjustment on your PC and many more cool features. You can use Adobe Acrobat to convert PDF to GIF.

Step 1. Download, install and launch the software.

Step 2. Open your PDF file in Adobe Acrobat, after that, visit the Tool menu, then choose Export PDF. To change PDF to GIF, select the desired option, here you need to choose "Image."



Step 3. Now, you will view different file formats on the screen. Select GIF format from the drop-down to convert from PDF to GIF. You can also click on the gear icon to configure the conversion settings.



Step 4. Select Export and choose the path you want to save your file through.



Step 5. Select save as to name and save PDF as GIF.







Part 3. How to Convert PDF to GIF in Preview on Mac

For MacOS, Preview acts like a default viewer for images (Such as GIF, PNG, JPG) and PDF files. Now, there are certain instances under which PDF files need to be converted into an animated GIF, a bitmap image form. Therefore, for converting PDF to GIF format, Preview comes as a very useful medium on Mac OS. Let us understand how to convert PDF to GIF image by following the step-by-step guide below.

Step 1. Open the Preview app, there visit File menu> then open and select your PDF file to open it.



Step 2. Once the PDF file is opened, visit the "File" menu and choose the "Export" option. A dialog box will open. Click on the Format drop-down and select the output file type GIF, to change PDF to GIF.







Part 4. 3 Other Recommended PDF to GIF Converter

If you're looking for a free program that will allow you to convert your PDF files into GIF images for free, then continue reading! All of these products are completely free to use, and you can try which of them works best for you!

1. ZAMZAR

This is a free-to-use online PDF converter called ZAMZAR. With the help of this tool, you can easily convert PDF to GIF free. There are a few stipulations involved in using the program, like having to give them your email to receive files, but it is easy to use and can convert your PDF into different formats.

Pros:

	The online program, best for one-time use.
	Can convert into a variety of image formats: GIF, JPG, JPEG, etc.
	Files get sent directly to your email.


Cons:

	You need an email address to receive the files.






2. PDF-online

Another Online PDF to GIF converter is PDF-online. Once again, it is free to use and has a couple of different options available, there are limitations on what you can do, which is normal for online PDF converters like this.

Pros:

	Adjustable quality output, so you can control the DPI of the GIF you'll receive.
	Can convert to other image formats: TIFF, JPEG, PNG, etc.
	The conversion can be downloaded from the website itself.


Cons:

	Limited use only, file will get deleted after a specific time has passed.






3. EZGif

EZGIF is another converter that is similar to the last two. It can be accessed online, meaning no hassle comes with downloading and installing another program into your computer. You can easily convert PDF to GIF using this website.

Pros:

	You convert more than one PDF at a time.
	The file can be downloaded directly from the website.
	There are different image conversion formats outside of GIFs like JPG and PNG.


Cons:

	No PDF file can exceed 5MB.
	The maximum total for all the PDF files is 80MB.




      
      
         
          
          
              

            
              Ivan Cook

              chief Editor

                    

            

          

        

      

      
       
       
       
       
       
       
       
       
       
       
       
       
    

  




  
      > Convert PDF > 3 Easy Ways to Convert PDF to GIF 
    

  




  
    
      
        
          
            GUIDES

            	How to Change PDF to PPT with PDFelement
	How to Easily Transfer PDF to Word
	5 Methods to Quickly Convert Excel to PDF
	How to Easily Compress PDF to Word
	How to Easily Convert PDF to Editable PowerPoint


          

        

        
          
            TOPICS

            	Compare PDF
	RoboForm
	ClickMeeting
	PDF Editor
	PDF Reader


          

        

      

    

  





	
		
			
				
					
				

				
					
						
							
								Company

								
									
										
									
								

							
							
									About
	Contact
	License & Terms
	Privacy
	Cookies Policy


							

						

						
							
								Partners

								
									
										
									
								

							
							
									Business
	PDF SMB
	Partner
	How to


							

            

            
							
								Top Products

								
									
										
									
								

							
							
									Filmora Video Editor
	FilmoraPro Video Editor
	Filmstock (Effect Store)
	UniConverter
	DVD Creator


							

            

            
							
								Top Products

								
									
										
									
								

							
							
									dr.fone
	Recoverit
	PDFelement Pro
	Mobiletrans


							

            

            
              
                Follow us

              
              
                	
                    
                      
                        
                        
                    
                    
                      
                        
                        
                    
                    
                      
                        
                        
                        
                    
                    
                      
                        
                        
                        
                        
                        
                    
                  


              

              
                
                  
                    LANGUAGE
                    
                      
                        
                        
                    

                  
                  
                    English
                    Deutsch
                    Français
                    Italiano
                    Español
                    Português
                    Nederlands
                  

                

              

              
            

          

          
            
              
                
                  Terms and Conditions
                  Privacy
                  Cookies
                  License Agreement
                  Refund Policy
                

                
Browser compatibility : IE/Firefox/Chrome/Opera/Safari/Maxthon/Netscape | Copyright © 2024 iSkysoft. All Rights Reserved.

                

              

              
            

          

				

			

		

	




	

 








 
 
 
